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There is now only one application development product sold by IBM, for iSeries, as of VAR5. This is
WebSphere Development Studio (Development Studio), which includes all four host compilers, all
traditional tools (ADTS = PDM+SEU+SDA+RLU+DFU+AFP+CGU), and unlimited licenses of the
workstation-based toolset named WebSphere Development Studio Client (formerly WebSphere
Development Tools).

If you are an existing customer who has a subscription, you can upgrade to Development Studio free
of charge. Without a Software Subscription, there is an upgrade fee. New licenses of Development
Studio are priced very competitive compared to the combined prices of all constituent products. As of
V5R1, there is no way to purchase the compilers or tools individually. So if you have RPG at V5R1 or
higher, you must have Development Studio and hence are entitled to Development Studio Client.

For consultants who do not have an iSeries of their own, but still wish to have the client tools,
Development Studio Client is also made available as a passport advantage product so it can be
purchased "off the shelf" from IBM Direct.

Development Studio has been a huge success, with over 80,000 licenses sold. Just as every
development machine used to have PDM and SEU, every development machine will now have all the
modern Application Development tools from IBM. This ubiquity is especially important for business
partners who build and sell software. These Business Partners are now free to build software using
any of the technologies or tools in Development Studio, and can assume their customers will have
the tools required to tailor everything from RPG to Java and Web user interfaces. This effectively
raises the lowest common denominator to a level unparalleled by any other operating system.
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WebSphere Development Studio Client Advanced Edition 6.0.1
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There is now only one application development product sold by IBM, for iSeries, as of VAR5. This is
WebSphere Development Studio (Development Studio), which includes all four host compilers, all
traditional tools (ADTS = PDM+SEU+SDA+RLU+DFU+AFP+CGU), and unlimited licenses of the
workstation-based toolset named WebSphere Development Studio Client (formerly WebSphere
Development Tools).

If you are an existing customer who has a subscription, you can upgrade to Development Studio free
of charge. Without a Software Subscription, there is an upgrade fee. New licenses of Development
Studio are priced very competitive compared to the combined prices of all constituent products. As of
V5R1, there is no way to purchase the compilers or tools individually. So if you have RPG at V5R1 or
higher, you must have Development Studio and hence are entitled to Development Studio Client.

For consultants who do not have an iSeries of their own, but still wish to have the client tools,
Development Studio Client is also made available as a passport advantage product so it can be
purchased "off the shelf" from IBM Direct.

Development Studio has been a huge success, with over 80,000 licenses sold. Just as every
development machine used to have PDM and SEU, every development machine will now have all the
modern Application Development tools from IBM. This ubiquity is especially important for business
partners who build and sell software. These Business Partners are now free to build software using
any of the technologies or tools in Development Studio, and can assume their customers will have
the tools required to tailor everything from RPG to Java and Web user interfaces. This effectively
raises the lowest common denominator to a level unparalleled by any other operating system.
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Installation

File Preferences Help

IBM Rational Product Updater
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WDSc 6.0.1 is an electronic update to
WDSc 6.0. It can be installed directly
from the Internet via the Rational

| Product

WDSC | RSE advanced |

| version | Tnstall Date | Detailed information
[A = % 18M wehSphere Development Studin ... 6.0.0 12-Jan-2006 2146 PM ~
ck 1 4 sl
s otk IBM WebSphere
. .
Development Studio Client
. . 7 .
for iSeries, Version 6.0.1,
Readme file
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WDSc Lite — Technology Preview

= WDSc Lite is a slimmed down workbench with only the:

Eclipse workbench (branded as the Rational Software Development Platform)
Remote System Explorer
iSeries Projects
iSeries Integrated Debugger
= Requires only 256 MB RAM !!!
= Optional installation feature for 6.0.1
Must already have full WDSc 6.0.1 installed
Creates a second copy of the workbench

= Fully supported technology preview
Preview of future packaging directions ©

6 WDSC | RSE advanced |
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WDSc Lite — Installation and Startup
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Remote Systems Explorer — 6.0.1 Enhancements

= V5R4 RPG, COBOL, and CL language support
Program verifiers (RPG & COBOL)
Syntax checkers
Online language references

= Multiple views of a single source member (Remote Systems LPEX Editor)

= Autosave
Unsaved changes periodically backed up to a local temporary location
Only for Remote Systems LPEX Editor
Preference to configure how often changes should be backed up

8 WDSC | RSE advanced | © 2004, 2006 IBM Corporation
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The Remote System Explorer Perspective
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This is the familiar default appearance of the Remote System Explorer Perspective.
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Customizing the Workbench

&5 MY PDM Perspective - PAYROLL - WebSphere Development Studio Client Advanced Edition for iSeries 2 o[- |

File Edt Source Comple Navigate Search Froject Run Window Help
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004000 C*  editting. Using t Update.. vs described on each display
004100 Cc*  format, you can tr change.. & maintenance application to
004200 C* another. The acti Save. lect on the selection formats
004300 c* determines if the _ Restore. dd a new racord to the file or
004400 c*  update an existing NN 2-Change...
004500 KKK KRR Rk Rk kA A% User Actions > 5 3-Copy To., P
Service Entry Point » 38 4-Delete =l
Run As
Run(Prompt) e
Debug As ' 10Restore... [+ep = o m ~ x
| EoaeEEns D & 11-Move [ Status [
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MYCOMPILE *PGM CLLE Ok
PAYROLL *PGM RPGLE 0K
PAYROLLD *PGM CELLE no errors oK
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b Command

The Remote System Explorer Perspective can be customized to look like this.
The editor takes up most of the space, now. It appearance has been changed.

The iSeries Table view resides below the editor and all other views have been either
closed or moved to the left margin as fast views.

14
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Customizing the Workbench

= Customize Perspective
— View can be
— moved
— re-sized
— closed
— hidden as Fast view
— Add other views
= Save Perspective AS...
Replace existing or create new perspective

= Use Window -> Preferences
Workbench, Perspectives
Make Default, Delete

Remote System Explorer | Advanced © 2004, 2006 IBM Corporation

Perspectives can be modified to fit your work style. Move, re-size or close existing
views. Open other views that you want to add to the perspective. Save the
customized layout as a new perspective using Window -> Save Perspective as.

Settings for your own perspectives as well as the ones shipped with the product,
can be maintained from Window -> Preferences, expand Workbench and select the
Perspectives page.

15
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. =1
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ok I Cancel —
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Remote System Explorer | Advanced

© 2004, 2006 IBM Corporation

There are two places in the preferences that allow editor customization: LPEX
Editor and Remote Systems, iSeries, LPEX Editor Parsers.

Besides appearance i.e. colour settings, the editor behaviour can also be modified.
Examples are syntax checking and column sensitive editing.
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RSE: User Actions

= User-Defined Actions ... like PDM!
— Right-click on iSeries Objects -> Work With

— User Actions
— Create, delete or change user-defined actions
— Scope them so you only see them when appropriate

— Named Types
— Create named types to scope actions against
— EG. “RPG” might be RPG + RPGLE + SQLRPGLE

= ... and even beyond PDM!

- Create user actions for libs/objects, members ... and even jobs
and IFS folders and files!

Remote System Explorer | Advanced © 2004, 2006 IBM Corporation

While IBM supplies a number of useful actions for remote iSeries objects, it is not
possible to supply them all. Like PDM, you can easily define your own actions. To
create your own actions, use the Work With actions in the popup menu for iSeries
Objects. These user-defined actions will appear in the popup menus for remote
resources. To avoid seeing all actions in all popup menus, you scope each action to
one or more object or member types. You first define named collections of object or
member types, then you create your actions and scope them to one of these named
collections of types. You actions will then only appear for object or members that
match one of the types in the collection. These actions can be created for objects,
members, jobs and IFS folders and files.
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Defining User Actions e =
Parent profile: |PhiCoulthard ~|
&Wob ot Action name: Add to Library List
Ject action
Deflne your own B Member action Comment: #dd selected library to b list
0 o = Obiect . . Command: Normal command -
actions for ObJeCt {la dd to Library List
=0 Member DDLIELE &M
and member opu (i Prink with SEU - ;
Popup PDM:-like subst’n vars
menus
Insert variable. . | Edit... | Browse. . |
. = Erompt...
I Remote Systems =, IR 4
X hew C i &
: B L::a\ ernecen Hew 4 ¥ Prampt First I Refresh after ¥ Show action
© A Linu Go Into W Single selection only [ | n
L B we > Lots of options |
+ iSeries Objects / Resource bypes for which this action will appear
+ @k iSeries Cammands )
= g Series Tobs & Open in New Window Defined Types Selected Types
1 3thy TF5 Files = show in Table Add>
= «Remove
Edit...
c§3 Refresh [T Mamed Types. . - -
Expard [ ol Commands.. FuE_prT Fine-grained
LIE: *LIB:* Scoplng
Apply Revert |

Close

Remote System Explorer | Advanced

Use Work With -> User Actions to define an object or member action. Object
actions only appear in the popup menus for libraries or objects. Member actions
only appear in the popup menus for members. When you define the action, you
initially specify a label to show in the popup menu and an iSeries command to run
when that action is selected. This command can use substitution variables that are
identical to those in PDM. There are also numerous options you can specify to
affect the action, and you can scope it precisely: for example, object actions can be
scoped one or more type and attribute pairs, and member actions by one or more
simple or generic member types.

19
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Substitution Variables

= Many substitution variables

Superset of PDM
= Different sets for objects vs members vs jobs vs IFS
= Use Insert Variable to see list

or Ctrl+Space to see list: or type ‘&’ to get prompted

<b Work With User Actions

Parent profile: IPh\ICou\thard LI
=1y Mew

: Action name: IAdd to Library List
h Object action
@\ Member artion Comment; IAdd selected library to lib list

E|--. (Object b Iﬁ
14 Add to Library List Cornmand: Mormal command
= By Member DDLIELE
W Print with SEU &H - Job description name, from Command Execution propertii # |
#15] - SBMIOE additional parameters, From Command Executi
#J - Job description libraryjname, from Command Execution pi

&L - Object or member library name

Insert varifl &MF - File name of temporary member, containing selected re: —
— Library name of kemporary member, containing selectec
Prompt Memb f temporary member, containing selecke

e

bject library, from Command Execution properties
¥ Prompt ‘ampile in batch. *VES or *NO. From Command Executior ™ |
IV Single s € L

Remote System Explorer | Advanced © 2004, 2006 IBM Corporation

All PDM substitution variables are supported for the command, and some new ones
that PDM didn’t support.

When you type &, you see a popup selection list, or you can type Ctrl+Space or
press the Insert Variables button. From the list, double click to insert the selected
variable, at the cursor position.

20
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Running User Actions L —r
T Remots Systems B 6d & | [raw: [copeLes hame

Mew Connection Library list position:

b
Local M List position: *FIRST 'I
B Linux GoTo 4 )
—_— Reference library: Marne:

E‘ My iSeries Expand To »

=1 iy iseries Objects —_—

2L work with libraties. .. &5 Refresh
Ed o .
. g: mnr: w|t: Dh]e;ts... Expand
- S Work with members., Collapse
i Library st P ™ advanced I~ All Parameters ™ Keywords
1 i

ijb User Ilhrar\as. Add To Library List. .. ADDLIBLE LIB[CODELAR)
@ My Source Files e
= g My Libs R Rename:

1=/, CODEABAR.*ib.prod BY copy

- E Paste
- . oK Restore defaults Cancel
elete
[+, CODELABOW *ibpra

W, CODELAEN. Mibprog ST in Table
I, CODELABOO.*ibproc  “hange..

-y CODELABO1.Hib.pro Save..
Restore...

User Actions

| § - Add to Library List

CODELABD4.*ib.pro
CODELABOS, *ib,pros
i, CODELABOG.*ib.pro Propertied

o A e e L e o

Create iSeries Project
1588 ENEs PIOIECE | I3 wark With Uiser isctions. ..

b - x

My iSeries I

>

ADDLIBLE LIB{CODELAR)

Library CODELAB added to library list.

Cause ... .. : If the ADDLIBLE command was used, CODELAR was added to the user library list, If the CHESYSLIBL
command was used, CODELAB was added to the system partion of the library lisk,

Comnmand INorma\ LI I LI Prampt. .. ur

iSeries Table View |iSeries Commands Log |iSeries Error List

£
= =%

W
21 Remote System Expl(

Remote System Details | Tasks

Once your action is defined, you can use it. Right click on an object matching one of
the types you specified, and expand the User Actions menu in the pop-up. Your
action appears in the menu. Select it. If you chose to prompt the command (via the
Prompt option), you will see the GUI prompt for the command. When the command
has finished running, it results are logged in the Commands view.
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User Actions for Jobs

= Yes, you can create user actions for Jobs too!

4P Work With User Actions

Parent profile: IPhlICuu\thard
i v Action name: ENDIOB
(% ENDIOB 4 End Job (ENDJOB)
Comment: End job immediately
Command; Mormal command hd Job name: QZRCSRYS Name
HDIOB JOB(BIRELILJBIIN) OPTIONIMMED) User: QUSER hlame
Murnber: 035269 000000-939959
How ta end: FTMMED -
Delay time, if *CNTRLD: 30 Seconds
Insert variable... | Edit. . | Browse... Delete spooled files: *HO id
Prompt... Maximum log entries: #SAME _¥ | Mumber
Additional inkeractive jobs: *HONE jhd
Prompt first: I Refresh after ¥ Show action
I~ Single selection onky [ Inyoks once
Apply I Revert
I~ advanced I~ all Parameters I~ Keywords
Close
ENDIOE JOB(D35269/ QUSER /QZRCSRYS) OPTION(*IMMED)

[s]4 I Restore defaults Cancel

You can also create user actions for Jobs, which will appear in the User Actions
popup menu for jobs in the iSeries Jobs subsystem under a connection. The
substitution variables include variables for the selected job’s number, user and
name.
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. You can choose
User Actions for IFS between QShell

. commands or QSYS
= And even IFS folder and files commands!
4P Work With User Actions &‘ ‘OS;"DD :nmman: j
— (05400 comman
o (05400 hatch cammand
Parent profile: |Ph\ICnuIthard j
E Qsh nrnand
i r;;wF Ider ack Action name: javardor P = s bl
older action 3 3 2
Folie ot comment: The substitution variables
=G ;idfarvac Command; 5hell command - Changel dependlng on
Baior fevator Fresarce_ana) command type
- File
fix ava 8B - I for IFS -~
i* javac 8 - Mame of this user action
ﬁ* jar § &D - File or folder last-rodified date
5 uniar Insert variable. . Edit... &E - Run in batch, *¥ES or *MO. From Command Execution pr For
ﬁ amake &FCN - Name of parent folder containing selected file or folder
i* Ko &FCP - Fully qualified path of parent folder, including name of QSYS
B e &FME - Extension part of the name of the selected file
U4 javadoc &FHR - Name of selected file without the extension CmdS
¥ Prompt first I” Refresh after W Show action &FP - Fully qualified path of selected file or Folder, inchuding ne
™ Single selection only ™ Invoke once 845 - Job descrintion library, from Command Execution propert
<
S I m I Iar for Resource bypes For which this action will appear
Loca| U n |X Defined Types Selected Types ${connection_name} - The nafn;e‘dof the connectlor‘v expdanded o)
12 - T ik ke
-al, ' Al s R e For
WIndOWS $local_hostname} - Local workstation host name 0
B = SEL $dlocal_ip} - Local workstation IP address Sh "
and LI nUX i Edit... ${resuar:e_date} - Last modified date of selected resource Q de
1 = | P — $dresource_name_ext} - Extension part of the name of the se
uSer aCtlons - $4resource_name_root} - Mame of selected resource without Cm S

$iresource_name} - Name of selecked resource, unqualfied
Jawa: java $dresource path drive} - Drive latter on Windows, smnty stri ¥
< >
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You can also create user actions for IFS folders and files, which appear in the User
Actions popup menu for folders and files in the IFS Files subsystem under a
connection.

You can create user actions that are QShell commands or *CMD objects as usual.
The substitution variables change depending on the type of command: for gsys
commands you get the PDM substitution variables, slightly different to deal with
folder/file names versus object/member names. For gshell commands, you get a
different list using eclipse-style ${...} variables, with many variables for all aspects
of the selected folder/file name, but a number of other environment variables.

Note the gshell-support is the same as when creating local, unix, windows or linux
user actions, which are also supported.
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Running User Actions for IFS

EP oo @ Hf >

» Hew Connection
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A Linu
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=1 ¥ 175 Files Erowse With 3

?,=:€> File systems

X

Optionally edit the command For this user action. Press Run to run it

5 Refresh
_%:b Root file system ¢ - ;
2 ¥pan
:‘? Hame: call Commmand
=5 My Folder ollapse :
=[] test P javado ArcTest.java
: 2 Rename

ArcCarteas.class Copy
ArcControls.class | i, tove
ArcTest,class

K rcTest java % Delete RuUn Canicel
. El» fxamplel.html Comple v [
(3 tes Compile (Prampt) ¥ V4
[+ (3 servertest
4 s javac
Compare With | iz jar
Replace With 3

Properties
? 5k wark with User Actions. .

i j I-*
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IFS user actions show up in the right click of the IFS files or folders, as shown here.

If the action is defined to prompt, then you get a prompt dialog where you can edit
the command before submitting it.
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Work With Compile Commands

= You can change IBM or vendor supplied compile
commands, and add your own

Heb oo m|mwF -

Tewe
G Inta
GaTo 3

3

& Open Member. ..
3 Open in New Window
EH Show in Table

i

=0 Work with objects. ..

S Work with members. .,

; Library list

% User libraries

> My Source Files

b My Libs C§3 Refresh

i* iSeties Commands Expand
oo b .
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In additional to user actions, there is specific support for creating compile
commands too. Use the Work With -> Compile Commands option from the iSeries
Objects subsystem under an iSeries connection. IBM pre-supplies compile

commands, and enables vendors to pre-supply commands as well, some of which
do.
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Customizing Compile Commands
Commands
4 Work With Compile Commands per {nerenber
Create new Parent profile: [Philcouthard ~| yP
or edit Member type: [rpeie < 'i add.. | memove |
existing
Compile Commands:
& [Fiew command Selected compile command: _
® Delete, Label: I CRTEMDRPG Brl ngS_ u p
Cony - G larger window
B Pacte ng ht RTENDRFG PEMEOeH) SRCFILE(BLIER) SRCMBRENTF L for editi ng
roew | click for [
2 Hove doun more - ' ¥
— | actions Insert variable... | Edi... Browse...
S§) Restore defaults . .
| / | Browse iSeries
L Comca oanter vy for *CMD object
&H - Name: of selected resource Revert | ]
&0 - Object fibrary, From Command Execution properties
&R - Replace abject when compiing. *YES or *NO, From Commar]
8¢ - Object or member text, in single quotes Close |
Subset of PDM
substitution
variables allowed

L li
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In the Work With Compile Commands dialog, you can create new compile
commands and edit existing ones. To edit an existing one, first find it by selecting
the member type it applies to (or add a new member type if necessary) at the top of
the dialog, and selecting the command in the list of commands on the left. Then edit
the command and press Apply. You can also right-click on a command to delete it,
copy/paste it, or re-order it. Note you cannot delete IBM-supplied commands, but
after editing them, you can restore them to their shipped value.
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Creating New Compile Command
4k Work With Compile Commands ‘X‘

Parent profile: |PhilCoulthard | Parent profile:
B

Member type: RPGLE w| Add.. Remoy Member bype:

Compils Commands: Comnpile Commands:
Mew compile command:

Mew command

New command
CRTEMDRPG
CRTRPGMOD

aile Command

CRTBNDRPG
CRTRPGMOD Label: [ ¥y R Campile: Command

Command:

’(ALL MYCOMPILE BL{%F &M

Insert wariable. .. | Edit. .. | Browse. .. /
Prompt...

Close ||
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To create a new compile command, select “New command” on the left, and then
enter the label to show, and command to run, and press Create. The command will
show up on the list on the left, and will also now be available at runtime, as we see
on the next slide...
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Running New Compile Command

=] ﬂ Library list
+ iy Q5vS.*ib.prod-sys

Ml @5¥5z¥ib.prod-sys GoTo 4
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erify )
Verify (Prompt) , event flle

B CRTEMDRPG

[Ely QRPESRC.file. pf-sre
[Ey SOURCE. *file.pf-sre
- [l QTEMP.¥ib.test-usr
i, POPALTPZ70,4lb prod-ust Add To iSeries Project...
E
E

Cornpile {Prompt)

) v Ea cRTRPGMOD
User Actions

[y, POPA1TD270.Mlib prod-us Make Available Offine

o Bl DDA BD3TA Hlik read e

=G5 Y X
jin Message Severit: I Line | Liocation | Conneckion | Lo
B RNS9308  Compilation stopped. Severity 40 errors Found in program. 50 a CODELAB/QRPGLESRC(PAYROLLG) My iSeries | —
B RNF2120  External descriptions for file MSTDSP not found; File is ignored, 40 27 CODELABQRPGLESRC(PAYROLLG) My iSeries
B RNFZ120  External descriptions for file PRIMST not found; file is ignored, 40 79 CODELABQRPGLESRC(PAYROLLG) My iSeries
B RNF2120  External descriptions For File RSMMST not Found; File is ignored. 40 30 CODELABQRPGLESRC(PAYROLLG) My iSeries
1 RWF7030  The name or indicator ACODE is not defined. 30 103 CODELAB/QRPGLESRC(PAYROLLG) My iSeries
] RWF7030  The name or indicator EMPAPL is not defined. 30 54 CODELABIQRPGLESRC(PAYROLLG) My iSeries
[l RWF7O30  The name or indicator PRCDE is not defined. 30 757  CODELAB/QRPGLESRC(PAYROLLG) My iSeries
Ll RWF7030  The name or indicator PRCMP is not defined, 30 264  CODELAB/QRPGLESRC(PAYROLLG) My iSeries

Remote System Details | Tasks | iSeries Table Yiew |iSeries Commands Log | iSeries Error List | Remote Commands
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Here we see our new compile command appearing when we right click on a
member of the type we created the command for. Note the checkmark appears
beside the last-used compile command for the selected member’s type. When the
compile command runs, if it generates an event file that event file is automatically
retrieved and the errors produced by the compile are displayed in the Error List
window, where you can double click to open the editor and position it at the error.

28



| IBM Software Group | WebSphere softwa

Defining IFS Compile Commands

= Yes, you can even create compile commands for IFS
files ... and even local, Unix, Windows and Linux!

4 Work With Compile Commands

Parent profile:

PhilCoulthard 25hell command
I ilCoul p I
Source bype:

I]ava vI Add... Eemovel
Compile Commands:

|New cDmmand: Selected compile command:

051400 command

&FCN - Name of parent Folder containing selected File or Folder
&FCP - Fully qualified path of parent Folder, including name of szl
Label: I Javac &FME - Extension part of the name of the selected file
BFHR - Name of selected file without the extension
Command: IQShe" command &FP - Fully qualified path of selected file or Folder, including name!

avac -deprecation -classpath . $4resource_name}

8 - Mame of selected file ar Folder
80 - Obiject library, from Command Execution properties
&R, - Replace object when campiling. *YES or *MO. From Canmman

Insert variable. .

<

i} ] 2|

$4container_path} - Path of folder containing selected resource, incuding name
$iresource_name_root} - Mame of selected resaurce without the extension
$iresource_name} - Mame of selected resource, ungualified

$dresource_path_drive} - Drive letter on \Windows, empty string on others

$dresource_path_root} - Root of selected file's path. "c:\" on Windows, or "f" on others
$dresource_path} - Path of selected resource, including name

$isystem_filasep} - File separatar, ™" on Windows, "f" on Unix and Linux
$4system_homedit} - Home directary on the target system, for the connection's user ID

. $4system_pathsep} - Path separatar on Windows, ":" on Unix and Linus
@ l i $4system_tempdir} - Temporary directory on the target system
Remote System Explorer | Advanced
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Running IFS Compile Commands

I I
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n iSeries Jobs Expand Compile command
& 'ﬂj LF‘S Files Collapse: javac -deprecation -classpath . ArcTest,java
-5 File systems _—
aat file system i Rename #
5 Home
=3 my Foder copy
=z test + Move
EE' arcTest % Delete Bun Cancel |
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ArcControls. class Compile 3
| ArcTest.class Compile {Prompt) »
cTest.jav User Actions 3
8 examplet html [T work with Compile Commands. ..
3 chest Compare With — »
- (3 servertest Replace With 3
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Here we see our new compile command appearing when we right click on an IFS
file of the type we created the command for. Note the checkmark appears beside
the last-used compile command for the selected file's type. When an OS/400
compile command runs, if it generates an event file that event file is automatically
retrieved and the errors produced by the compile are displayed in the Error List
window, where you can double click to open the editor and position it at the error.
When a QShell compile command runs, the errors are shown in the Command
view, and are double clickable.
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*Command Subsyste
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There is a preferences dialog that has many preferences which affect substitution
variables for user actions and compile commands.
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Running Interactive Commands in RSE

There are three types of iSeries commands in RSE
Normal -> runs in RSE batch job (with adopted user ID)
Batch -> runs via SBMJOB (using preferences for JobD, etc)
Interactive -> runs in interactive job (you must do STRRSESVR)

You will see this prompt in many places. Eg:
When defining User Actions

When defining Compile Commands
When running commands in iSeries Command log view

& Work With User Actions

Parent profile: IPh\ICDuIthard

= [ Mew Action name: Add to Library List
h Object action
H ‘E\ Member action Comment: Add selected library to lib list

= By Object
- ol Add ko Library List omman Orma comman
E||b Member " Mormal command

a T Batch command
b Print with SEU Interactive command

Select in what job the command will run, Press F1 For details.
T

L
Remote System Explorer | Advanced

Within the Remote System Explorer, there are 3 ways to run commands on the
iSeries: normal, batch or interactive, as described here. You will see the prompt for
the three types of commands throughout the RSE, so its important to know the

differences between them.

© 2004, 2006 IBM Corporation
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Step 1. Run STRRSESVR in any emulator

= i|Session A - [24 x BO]

Eile Edit Y¥iew Communication Actions ‘Window Help

LY | (% & 3| & The profile-qualified
R) RSE connection name
to associate this
PhilCoulthard My iSeries interactive session
- with
Additional Paramcters Where to put user
T value, $FRY, (DFT space for history

Host name of your PC

To run interactive commands, you must run the STRRSESVR command from within
an emulator. Specify the name of the connection within the RSE to associate this
interactive session with ... qualified by profile. It may help to select the “Qualify
connection names” option in the dropdown of the title bar of the Remote Systems
view in the RSE, so you can see what profile your connection is in. Also specify a
library unique to you, to hold *PRV values for this command, and of course your
PC’s hostname or IP address.
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Step 1. Emulator is now reserved...

Actions  Window  Help

8| (% & 3] &l

IBM RSE Communications T

Connection Hame: PhilCoulthard.My iSeries

ALL right:

When the STRRSESVR command is successful, it will reserve the emulator by
putting up the screen shown here.
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Running Interactive Commands in RSE
= Step 2: Run interactive command in RSE

WL iSeries Commands Log ._7'_ - X
My iSeries |
ADDLIBLE LIB{CODELAB) -~

Library CODELAE added to library list,
Cause .. ... : If the ADDLIBLE command was used, CODELAE was added ko the user library list. IF the CHGSYSLIBL

command was used, CODELAR was added to the system portion of the library list.

command [Interactive x| [sTRPDM x| Prompt... | Run

Remote System Details |Tasks |iSEriEs Table Wigw liSEHES Commands Log |iSeries Error List

My iZeries |

STRPDM
Cormmand STRPDM has been sent to the interactive job. Switch ta the emulator where the STRRSESYR cammand is Funning

For this connection

j Prompt... | Run

Command [Interactive =l

Remate System Details |Tasks igeries Table Wiew llSer\es Cormrmands Log | iSeries Errar List

i 1 ¥ |
© 2004, 2006 IBM Corporation
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Now, within the connection associated with the STRRSESVR command, you can
run interactive commands from within the RSE, and debug interactive programs.
The example here shows running STRPDM from the iSeries command log view.
You need to give focus to your reserved emulator to see the results...
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Step 2: ... and your command runs in emulator:

=1 Session A - [24 x BO]

ment Manager (PDM)

¢ with gr

9. Work with user-defined options

ih o command

... and here we see that the reserved emulator is now running the interactive
command we entered in the RSE.
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Run: from popup menus
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‘/ B atc h Wl G5vS2.#ib.prod-sys See
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Interactive 51 i
. W QTEMP Fibtostusr % Delete
v"Multi-threaded
Change...
Save..
Restore..,
User Actions 3
R u n A S Service Entry Point b
iSeries application in RSE Job
EMPIST file.pf-dt: =gy nprompti(F) Batch
EVFEVENI.*I’M&‘DF-( Debug As(T) D
?g ﬂ;}ggﬁzi!';:;';; Debug (PrompE)k) »  Multithreaded
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You can run programs from the Remote Systems view or the iSeries Table view in
four ways:

In the RSE communications server job
*In a batch job

*In an interactive job

*In a server job

In the first case, running the program in the same job as the Remote System
Explorer communications server job,will tie up that job until your program ends. With
batch and interactive jobs, you cannot monitor the status as easily, however, you do
not tie up your communications server and you are notified when the program ends.
Batch jobs work as you would expect, your application will be submitted to the
default batch subsystem.

Note: A multi-threaded debug session creates a new server job and this way keeps
the RSE communications server job free for other tasks.
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Run Configurations: for easy re-use!
E

File Edt Mavigate Search Project Run Window H

Create, manage, and run configurations
5-08e] 0% -G ’ ’ j
B oo e

E Rep o w | o  Fun.. Configurations: Mame: | My Beries program for run
2 = B Compied Applcation
5 || -8 tew Connection = .58 iseries: Run Application i

B Loca How To Start |X§: Commen |

it % igeries: Run Batch Applic
-4 My Server ||

1B iSeries: Run Interactive ;
£ 8 iSeries Objects && m gy Cornection: [My Server R
2 work with libraries... B Maw_confiquration (
2 wiork with objects. . % igeries: Run Multithread
U3 work with members. .. 88 Java Applet -
= Urary st =) Java Appication Command to start application:
-l QSY52924.%ib prod-sys B 3ava Applcation in iSerie | CALL PGMERSELAB4/PAYROLLG) =]
il Q5¥s.¥lb.prod-sys 5§ JavaBean
: -y Wnit

il Qsvsz.*ib.prod-sys
W, QHLPSYS.Hib.prod-sys
I, QUSRSYS. Hib prod-sys
il QGPLAI.prod-ust B websphere v5.1 Applica
B, QTEMP.Hib best-usr 52 websphere S Applicatic
B4, *lib.prad-ust

C1.*pamn.clle
R1.*pam.clle
VCOMPILE. *pgm.cle

@ Runrtime Workbench
. flf Seript Host Application
Server

Prompt...
YROLL. *pgm.rpgle romp! |
YROLLD. *pgm.chle
Fpgm.rpe 2
file. piff « ol
New Delete Apply. Revert

4B Remate System Explorer - WehSphet velopment Studio Client Ad

Bun I Close
Existing run configurations are easily
accessible in run pulldown!

=35

Ha

Run configurations are for powerful re-use. If what you want to run a program that
takes a number of parameters, or is not straightforward to launch, you can predefine
this information into a named configuration. Once created, the configuration
appears in the configuration list, and can be selected from there. Every
configuration run also appears in the pulldown menu of the Run tool bar button.
Clicking the Run tool bar button itself, will run the previous configuration again.
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Drilling Down

= Typically we start using the RSE by just expanding:
— Expand Library list to see libraries on lib list
— Expand a library to see all objects in it
— Expand a source file to see members in it
— Expand Home directory to see folders in \nome in IFS

— Expand a folder to see all folders and files in it
— And so on

= But sometimes this produces lists that are too big
— Its unwieldy to scroll through thousands of things

— You really want to keep lists small, to a few hundred at
most

Remote System Explorer | Advanced © 2004, 2006 IBM Corporation

The Remote System Explorer is all about random access to remote things ... like
stuff in QSYS, or jobs, or IFS files. While it is designed to be immediately useful by
merely expanding nodes to drill down to what we want, sometimes that can produce
unsatisfactory results if this results in vast numbers of items.
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*LIB Expand To - For Quick Filtering
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= i Library list ﬁ E% ; m QY5 Mib.prod-sys
m (55, *lib. prod-sys Change Current Library. .. Save Files m QEY52. Hib.prod-sys
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One very quick way to reduce the amount of things is to use the Expand To object
for libraries. It allows you to expand a library to see only objects of a particular type.
This subsetting remains in effect forever, even when you re-expand with the plus
sign, until you subsequently choose All or any other expand-to criteria.
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Introducing Filters

= Eventually you will need to see a subsetted list
— Using criteria like generic names, types and attributes
— All subsystems (nodes under a connection) support “filters”
— These allow fine-grained control over what is shown in the RSE.
= To create a filter, right click on any subsystem and
select New -> xxx
— iSeries Objects -> New -> Library Filter, Object Filter, Member Filter
— iSeries Commands -> New -> Command Set
— iSeries Jobs -> New -> Job Filter
— IFS Files -> New -> Filter
= Or use the fastpath Work With XXX... prompts under
iSeries Objects

Remote System Explorer | Advanced © 2004, 2006 IBM Corporation

Eventually, you will find the need to see a subsetted list. That is what filters offer,
and the RSE has extensive filter support.
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Introducing Filters
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RSE filters for iSeries Objects

= Library filters
— Specify simple, generic or special library names
= Object filters
— Specify simple / generic object names, lib-qualified
— Library name can be simple, generic or special
— Object name can be simple or generic
— Specify simple / generic object types and attributes
— Can specify one or more type:attribute pairs (OR operation)
= Member filters
— Specify simple / generic member names, lib / file-qualified
— Specify simple / generic member types
— Can specify one or more member types (OR operation)

Remote System Explorer | Advanced © 2004, 2006 IBM Corporation

There are three types of filters you can create in the iSeries Objects subsystem.
1. Library filters. These list libraries when expanded.

2. Object filters. These list objects when expanded.

3. Member filters. These list members when expanded.

We will see an example of creating each of these. If you are an existing CODE user,
you can use File->Import to import filters from CODE Project Organizer.
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Library Filters

B oo a|HsF v

Mew Connection
Local

= Linux Library Filter :
E“ My Ise”?s . Create a new iSeries library filter =i
- eries Objects =

Work with libraries. ..
mx xt: :1‘2:;:5 Library: | *LAg" || Browse... |
- i . )
Etriall [ Specify s_,lm_ple, special,
% % IF5 Fies or generic library name

=By ToRASIFE

>

Library Filter i
< Back Bexils Mame the new filker = E

Filters are saved for easy re-use. Specify a unique name For this filker, This name will
appeat in the Remote Systems view, and will be expandable.

Filter name: IMy Libraries| SpECIfy a fllter name | —

Remote System Explorer | Advanced © 2004, 2006 1BM Corporation

Here we use the Work With Libraries... prompt to create a library filter.
Specify the library name, simple or generic, to list when this filter is
expanded. Note the generic names in RSE support two asterisks, not just
one as is the case with PDM. On the second page, specify the name for
this filter.




| IBM Software Group | WebSphere software

: : . Hew 3
Expanding Library Filters
Go To 3
& Open in New Window
EH show in Table
&9 Refresh
Hew Cannection - Use Change
Local . .
4 Lnux == | to edit filter
= ‘ My iSeries
= ﬂa iSeries Objects m Iater
= 3 waork with libraries. .. i Rename
[ Filter created successfuly, Expand this again to create another B
}:9 wWork with objects.,, o
[+]-3 Work with members. .. A Move
e Library list % Delete
! o .
Y Leerbrares Filter is created, and
B it Libraries . <+ Maove Up
iy ADTILES b prod expanded. It lists all 3 Hove Down
[, ADTSLABIL. *lb.prod . N )
il ADTSLAB1, o libraries matching shon i Table
+/- i, CODELAB. "ib.prod N R X
# i, CODELABADM. *lib prod the glven Crlterla Froperties
[, CODELABCW *ib.prod .
e Ml CRNFLARYY *lh rad

Filter exists until
you delete it
Filter exists in all
connections by
default
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© 2004, 2006 IBM Corporation

When a library filter is created, it shows up in the list of existing filters for iSeries
Objects. You can edit the filter by right clicking on it and selecting the Change...
action from its popup menu. When a library filter is expanded, all libraries matching
one or more of the filter's filter strings are listed underneath the filter. Note that

these libraries can subsequently be expanded, just as they can for the Library List
filter.
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Obiject Filters

E Remote Systems

Lo m|HF > o

% Mew Connection
+ B Local
w0 Linu
= My iSeries
= f'u iSeries Objects
+ 5 Work with libraries. ..

“work with ohjects.
-2 Wark with meml
+ ﬁ Library list
+ - jf User libraries
o g My Libraries
] ik iSeries Commands
1 & iseries Jobs
= ¥y IF5 Files
4 By ToRASIFE

q

Object Filter

Create a new iSeries object filker

Library:
Object:
Object type:

Object attribute:

—1 special, or generic

Specify simple,

library name

W'— Specify simple or
7 === | generic object name

[*FILE =1 Browse. .

e \ ~ Specify object type
L
Mori P25 Specify simple or
(i12:25002) generic object
attribute

| Cancel

Mame the new Nger

Filters are saved for eNgy re-use, Specify a unique name For this Filker. This name will
appear in the Remate SWtems view, and wil be expandable.

Remote System Explorer | Advanced

Filtet name: | My Objects

Here you use the Work With Objects... prompt to create an object filter to list objects
in one or more libraries. Specify the library, the object, the type and attribute filtering

criteria. All but the object type can be generic.

On the 2" page of the wizard, you specify the name for this filter.
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Filtering objects by type + attribute

& Select Object Type
When More Sclct an cbject type:

Types>>> pressed

Object Filter .
Create a new iSeries object filker =i
>
Library: | ADTSLAB ]| erowse.., pis
Object: [ B =]+ Browse... cBLE
Type and attributes to subset by: EL3S Prompt f0r ObjeCt
FFILE bz EtEE ttribut
i I vl- Erowse... attripute
Specify multiple |1, 1 i
* |+ Browse... cop
object type + e v
i . Change M DFUNOTEXC
attribute pairs romre e
PAs3a
pLI | |
Will list all objects with e
| S RPG
any of the specified [ . | e | v
—  types+attributes Cancel_|

R ¥
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By using More Types>>>, you can specify more than one object type and attribute
combination. Note the attribute can be generic. This multiple-type support is beyond
what even PDM supports, and allows for extremely specific lists based on filters.
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GoTa 3

X e @ HFr

Expanding Object Filters G ’

& Open in New Window

Mews Connection
Local
Lirwrz
=y My iSeries

- iSeries Cbjects
3 Work with libraries. .
work with objects. ..

LABSETUP. *pgr.clp
PRTCUST. *pgm.tpale
PRTINYV.*pgm.clp
PRTINVR., *parn.rpale

-

x
~

[ Fiter created successfully., Expand this again to create anather

EH show in Table

&9 Refresh
Expand

Collapss to edit filter

B (ater

Use Change

work with members. .. i Rename
Wi Library list e
W User ibraries Copy
My Libraries & Move
% Delete
Fpgm.rpgle 1 1
e Filter is created, and e
CLRMSG. *agm.clp ¥
oot expanded. It lists all 8 ove oo
GETTIME. *pgmn.cle 1 1 h Tahh
e objects matching  cownTale
IAVASETUR. *pgm.clp H H A Properties
LABCLEANLP . the given criteria.

RTWUSRCLAS. *pgm.clp

Filter exists until
you delete it

Remots Systems | Team

Filter exists in all

connections by default
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When an obiject filter is created, it shows up in the list of existing filters for iSeries
Objects. You can edit the filter by right clicking on it and selecting the Change...
action from its popup menu. When an obiject filter is expanded, all objects matching
one or more of the filter's filter strings are listed underneath the filter. Note that

these objects can subsequently be expanded, if they are files, just as they can from
the Library List filter.
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Neww Connection

+ Local

‘6 Linux

=18k My iseries

=1 & iSeries Objects

Member Filters

[E: }:b work with lbraries. ..
] =2 Work with objects...
Jiork with members. .

Lo E|HF v =

Member Filter

Create a new iSeries member filker

g Library sk
[E: i%? User libraries
il My Libraries
[ i’:# My Objects
B ik iSeries Commands
&+ 8y iseries Jobs
-y IFS Files

[y TORASIFE

Here you use the Work With Members... prompt to create an object filter to list
objects in one or more libraries. Specify the library, the object, the type and attribute

Library! [aoTstag ‘/ =
File: AT s -

4

e
J Browse...
I I

Member: I *

—

—~ Specify simple,
special, or generic
library name

| | Specify simple or

generic file name

Mernber type: | RPG*

Specify simple or
generic member name

Expan d ce members

;IJ Browse...
More Types=»
=

™ Data members

[ More types>> (next page) |

~ Specify simple or

generic member type

< Back MNext =

Remote System Explorer | Advanced

'mber Filter
Mag the new filter

appear in the Rgote Systems view,

Filters are sa®d for easy re-use. Spedfy a unique name For this Filker, This name will
and will be expandable,

Filter name: | My Meribers|

filtering criteria. All but the object type can be generic.
On the 2" page of the wizard, you specify the name for this filter.

© 2004, 2006 IBM Corporation
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Filtering by member type
When More
& New —
Member Filter TypeS>>> preSSEd 4 Select Member Type |£|
Create a new iSeries member filker :i:D Select a member type:
> - -
- e u
Lbrary: | ADTSLA ;IJ Browse... | EBL
File: R PGLESRC) LIJ Browse... | EEELE
Member: I LIJ Bromse... | S[EE J
I source members I~ Data members EE@}
lember es [0 subsel T CPRLE
D:\PGE el ey Member bype ggg':
CBL* - IJ Browse. .. 1CFF | |
5 B Add \ I|‘-\l|FENLI
Specify multiple member — g [
5 MNUCHD
types. Handy when generic Remave e
name won'’t work e R
| < Bark. Mext = | Finish I Cancel | e
Will list all member with |
any of the specified types

N ¥ |
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By using More Types>>>, you can specify more than one member type. Note that
each type can be generic. This multiple-type support is beyond what even PDM
supports, and allows for extremely specific lists based on filters.
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Expanding Member Filters e

GoTa 3

& Open in New Window
EH show in Table

Bepaoo m|FF v x

[\I:E\c;[onnectlon &83 E:;T:; USG Change
8 L _ “= [ 1o edit filter
E--‘ My iSeries

e e T e
S Work with libraries. .. o Reneme

T Work with objects. ..

work, with members. ., Copy

Library list 4 Move
User libraties

My Libraries . . # Delete
vy Ot Filter is created, and P
" paimoL. e expanded. It lists all 8 veve towr
[y PAYROLLG.rpgle . R
[+ ik iseries Commands members matChlng Show in Table
1+ ﬂ iSeties Jobs 5 o a Properties
5 ¥ 15 Fles the given criteria.
By TORASIFE

Filter exists until
Remate SystemsJTeam you delete |t

Filter exists in all
connections by default
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When a member filter is created, it shows up in the list of existing filters for iSeries
Objects. You can edit the filter by right clicking on it and selecting the Change...
action from its popup menu. When a member filter is expanded, all members
matching one or more of the filter's filter strings are listed underneath the filter.
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Filter Pools

= Eventually you will have too many filters!
— Or you will want a filter not to show in all connections
= Time to turn on “Show Filter Pools”
— Expanding subsystems will then first show filter pools
= Filters are grouped into named pools
— By default they are added to the “default filter pool”
— You can create your own filter pools
— Then add filters to it
— Expand a filter pool to see just the filters in it
— Connections reference filter pools ... only see those you reference
— The default pool is always referenced
= Filter pools group filters
— Nothing more than a named collection of filters
— Allow you to group filters by project, release, connection, task, etc.
- ¥ |
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There is an advanced feature in the RSE for partitioning filters into named
collections, called filter pools. To enable this, you must select the "Show Filter
Pools" preference. Actually, all filters are contained in a filter pool. By default, they
all go into one IBM supplied filter pool, named Default Filter Pool. By turning on the
Show Filter Pools preference, you will see these filter pools when you expand a
subsystem. When you expand a filter pool, you will then see the filters. Filter pools
can be used to effectively group filters by task, or project, or release, or developer,
or whatever you like.
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Show Filter Pools

Red oo m|mF

vX||

Mew Connection...

=8§ Mew Connection
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-5 work with libraries. .
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=5 ﬂ: iseries Objects

=Tk
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Work with objects...
work with members. .,
[+ Library list
@ User libraries
[+ My Libraries
i‘% My Objects
ﬁ:% MMy Members

5& i* iSeries Commands

T e -THe Mypc Filter Pool
[ My Libraries N A = iSeries Jobs
i' My Objects f _*;o My;cbﬁlter Pool
ﬁ My Members \i *H IFS Files
-k iseries Commands (=T Mypc Filtr Focl
-5 i) 3 Remote Systems | Team
Connections | Subsystems Show Filter Pools
- Subsystems L e Pyl changes the view to
- Filters - =T show filter pools first,
Remuote Systd = Fl|terS .
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Here we see how to turn on the Show Filter Pools preference. Once enabled, when
a subsystem is expanded you see not the filters, but first the filter pools referenced

by this subsystem in this connection. When a filter pool is expanded, then you see
the filters within that filter pool.
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= iy iSeries Jobs
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- =% IFS Files
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Create a Filter Pool

4 New Filter Pool

System Filter Pool

Define a new pool for Filkers *50
= 7]
Eeh oo ml|EF >
4 i Library... Paal name | My Paol
e Podl... Profile IMyPC LI
! Go To
£l E My Geries Filter Pool Reference ¥

Now you can create a new
filter pool for a connection...

Xep oo a|nsf

B shaw in Table

C§3 Refresh
Expand
Collapse

@ Rename:

N

- e | o

...and then create filters

in that filter pool

¥
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To create a new filter pool, right click on the subsystem, then select New -> Filter
Pool...

All you need to specify for your new filter pool is a unique name. This is what you
see when the subsystem is expanded. Never mind the Profile prompt for now, we
will explain that later. It is defaulted so you need not think about it. When Finish is
pressed, the filter pool is created, AND a reference to it is added to this subsystem
in this connection. No other connection has a reference to this new filter pool yet!
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Reference a Filter Pool

= ~ 1 | By default, only the connection where
Reh oo m|mwfF .

o X tewGroadin you created the filter pool has a

+- acal . o E—
B Lo reference to it, so filters created in it
=18l My iSeries a

o) Bl serios Objects only appear for that connection

. B iseries Jobs
- % IFSFiles
= By TORASIFE
= @ iSeries Objects Mew Connection
--:E' Mypc Filter Poal
gk iSeries Commands
@ iseries Jobs
[Ty IFS Files

Eepoom|HF > x

4 .} Library...

:-:}1 Filter Pool

Filter Pool Reference b

/ Open Member, .,
28] Cpen in New Window
[ show in Table

Remote Systems | Team

Work

. To share a filter pool between
ek ™1 connections, create a reference to

iseries Commands

& 1Seties Jobs ﬂ the fllter pOOI from Other
[+ 'ty TFS Flles °f Select A 1
: connections
Chang

Release Interactive Job
Remate Systems | Team _ _

N | LA
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By default, filter pools you create are not shared by multiple connections. To affect
that, create a reference to the same pool from multiple connections. Note any
changes made to the filters in the pool are now immediate across all shared
connections.
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Work With Filter Pools

In Show Filter Pools mode, there are
two new actions on subsystems
like iSeries Objects:

E| ‘ My ISeties

= iSeries Ohjects

e Mypc Filter Pool
1@ My Pool

i5eries Commands
iSeries Jobs

IFS Files
TORASIFE

B
i & Mypc Filter Pool

eries Commands

iseries Jobs
Ty IF5 Files

1. Work With Filter Pools

B e

Mew
Go Inte
Go To

2. Select Filter Pools

/ Open Member. ..
& Open in Mew Windaw
EH showin Table

&9 Refresh
Expand

Callapse i g
) compile Commands. .. = e Mypc Ficer Pocl
®f Select Fiker Pocls. .. B 11, Pool

€ Work With Filter Pools

‘Work with Filter pools
R I
= B Team [Move selected Fiker pool to a differert profile]
- F® My Filters
*..78s Team Filker Poal

| |= B mvec

[, Mamed Types...

1. WW Filter Pools:
One stop shopping for filter

v Paal

lypc Filter Pool

pool management

2. Select Filter Pools:
Easily manage which pools this
connection references
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When you are in Show Filter Pools mode, you will see a couple actions on
subsystems, for managing filter pools and managing references to filter pools.
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Working disconnected What you can do while disconnected j

—

v' Edit local and offline source files / mbrs
v’ Syntax check RPG, COBOL, DDS
v’ Syntax check CL for cached commands
v Prompt RPG and DDS
v Prompt CL for cached commands
v Access language help for RPG, COBOL, DDS
v Access CL help for cached commands
v’ Verify RPG, COBOL, DDS for those members that are cached

| What you cannot do while disconnected I
/

v’ Edit, design or comﬁe host source members
v Run or debug host programs
v Run host commands
v" Syntax check, prompt or F1 on CL commands not cached
v' Verify members not previously verified

A . ] ¥ |

Remote System Explorer | Advanced © 2004, 2006 IBM Corporation

This summarizes what can and cannot be done when working in disconnected
mode ... that is, without a live connection to an iSeries host.
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Caching

= Verify source member
= Caches information kil Bl TAns
= To update cache: || = ||_“ |
Select Verify (Prompt) geit [Select to enaure ot all cached Fems are refveshed|
Select Refresh cache
Click OK

Source  Compile  Mavigate Search  Project
e 3

Prompt F4

Synkax Check All

4 veri

Clrl+3hift+y

Convert All Ta Free-Form

Select Format Line...

Show Indentation

Shiow fields

TCOPY Member »

ILE RPG Help 3
Restare Defaulks Apply |
=

Resequence All Lines
Refresh Ctrl+FS

Remote System Explorer |

When you verify a member, the external references are automatically cached
locally. On subsequent verifies, the local cache is used. To force a refresh of the
cache, prompt the verify action and select Refresh Cache.
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Cache Settings

4 Preferences @

=)

Plug-In Development
Prafiling and Logging
RAD

Remote Systems
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Command Executio
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£ Server
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< T | 3

| Cache |

™ iork OFfline
L
& Cache CL help and prompts using host name as the key {most accurate),

" Cache CL help and prompts using host release as the key (quick).
" Cachg C1 help and prompts ignoring host name and release (quickest).

| Disable caching

I Waximum cache size (MB) | 50
Current cache size (ME) Calculate

Cache location |D:destiwnrkspace\.metadatal.p\ugms\tnm.ihm.etnnls.isarias.cnralcachn Browse. |

Clear the current cache Clear

Restore Defaults apply

Import... | Export... |

W
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You can affect cache settings via the Cache preferences page.
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Make Available Offline
I;

File Edit Mavigate Search Project Run Window Help
Bep oo m|f v x EREERIE T R
New Connecton w7 o
DE‘%;? s m [ nordertowork | |5 en o cooni
o 3 Worn s s offline, you have %
:I:;urr:r:v:lt;msmbers‘.‘ ;Z:‘; to make a |0ca| — | @ = Pras0rm_ORDLIE
i vt ®° Delte copy of your This creates an iSeries
i e o member first. project, and imports the
: oo Use Make Ayallable / member(s) to it. This is
1 e cama s acions | Offline / where you work offline
i E ?g&;igas .e«- Prniec‘-‘ iSeries Project Navigator | Navigator | Bookmarks |
Compare With
—— What are iSeries
Projects?
Stay tuned...
Remote Systems | Team

S 1 1
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To prepare for working offline, use the Make Available Offline action on the
members you intend to edit. Then, while offline, you edit your source from the
iSeries Projects perspective. More on iSeries Projects later.
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iISeries Projects

&P Select Perspective x|

= A special project type ) comsenent Test -

%CVS Repository Exploring

—For holding source destined %!-;Data
Debug

to be compiled on iSeries Fea
TEEGL web
@&1

= A dedicated perspective

Fd
—For working with all and only é';j:j: —
ISeries projects PR e
Cancel |

i 1 ¥ |
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There is a special project type designed to hold source that is destined to be
compiled and run on an iSeries. There is a wizard for creating a new iSeries Project.

There is a special perspective for working with iSeries projects.
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What is an iSeries project?

= Typical Eclipse project
— Contains folders and files, can be shared by a team

— Can have its own tools and perspectives
= But also

— Holds copies of some source members from an iSeries library

— Those copies are “pushed” up occasionally and the project
re-built

Remote System Explorer | Advanced © 2004, 2006 IBM Corporation

An iSeries Project is a typical Eclipse project. This means it contains folders and
files that are in the local file system of the IDE, but these can be synchronized with
a central repository for team support.

Since the files are local, there is actions to support "pushing” those files up to an

iSeries library, where they become source members. This is done prior to compiling
or "building"” the source for the purpose of testing.

66



‘ IBM Software Group | WebSphere software

iISeries Project Library, files, members

= iSeries Project
— Each iSeries project is associated with a single iSeries library
— 1to 1 association
— Use File -> New -> iSeries Project wizard to create
= iSeries Source Physical File
— Source physical files represented as folders in the project

— CCSID, record length, IGC data and description stored as “metadata”
for folder

— Use New -> iSeries Source Physical File wizard to create
= iSeries Member
— Members stored as files within “source” folders
— Uses format: memberName.membertype ORDRENT. RPGLE
— Use New -> iSeries Source Member wizard to crate

B ! I‘

Remote System Explorer | Advanced © 2004, 2006 IBM Corporation
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& iSeries Projects - PAYROLLC.CBLLE - WebSphere Development Studio Client Advanced Edition for iSeries
Eile Edit Source Compile Mavigate Search Project Bun Window Help
H-HR S @5 ¢ AR S - AR R '
2 B iSeries Project Navigstor w X || #/PAYROLLC.CBLLE X 22 Outline x
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I EMPMST.PE 000008 DATE-WRITTEN. October 12, 1899, |- PROCEDURE DIY
[ MsTDSP. DSPE oooogs DATE-COMPILED. 0000-MATH,
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+ (b T7_WFLABK: 3 | 5 D300-EXIT,
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Here we see the iSeries Projects perspective, which you can explicitly
open. The primary view is the iSeries Project Navigator that allows
exploration of all existing iSeries Projects. There are wizards lauchable
from the toolbar for creating a new iSeries Project, or creating source
physical files and source members within an existing project. The iSeries
Projects perspective includes a full copy of the Remote Systems Explorer,
as a view, for your convenience. This allows you to easily work with the
contents of the associated library while simultaneously working with the
local copies of the source within the project.
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iISeries Project wizard

% New |§|
iSeries Project Properties Choose
Specify the iSeries project properti| Connectlon

from RSE list
Connection: My iSeries 3 Mew... |
Project contents

Assodiated library: IAPILIB ;\Browse.‘.‘;l
¥ Use default

Directary; | DilwdschworkspacelMy iSeries Project Browse, ..

iseries Project

Give your
project a
name

iZreate a new iSeries project that maps to an iSeries lib

Project name: |My iSeties Praject

Specify the connection and library name to associate with this iSeries praject. The
connection allows For remote access ta the iSeries host machine. Code changes
made locally are pushed ko the specified remote library, That library is also used For
Specify the name and location of the iSeries project being created. An iSeries st s o s e 2 ezt

project al\gws for lacal development, while performing builds on & remote iSeries N T T " "
host machine. Identify Associated Library: this is the
target library for pushes and builds

< Bark | Mext = I Finiish Cancel I < Back | Hext = II Finish I Cancel |

4
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Here we see the iSeries Project wizard. First, give the project a name. Any
name you want! Then select or create a connection (from the RSE!) that
identifies the iSeries with which this project is associated. Also select the
library on that iSeries where the contents of this project will be pushed to.
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iISeries Project Wizard (next page)
Build style controls how the iSeries

project is built On the remote System Enter the project's source file that contains the COMPILE. CLLE and BIMDLCLLE members that will be

uploaded to build this project.

Build Source File:

iSeries Project Properties _ | oaske
Select and configure the active build style For this project, Er— ¥ automatically generate COMPILE.CLLE prior to each build

v utomaticaly oush allchanasd members oriar o buid

Active build style: Cancel

Configure. .. |

Command

Hone Specify Build Style and
style configuration parameters

This build style will upload <L programs specified in the configuration, compile them, for Iserl es PrOJGCt
and then run them to build this project, The compile commands can be automatically . . .
denersad. more information on next slide ...

Provided by IEM plugin "iSeries Projects - Remote Build Styles Plugin” version 5.1.0 c&, Command Build Style Configuration

Enter the command to be submitted ta build this project.

Build Command:

I~ automatically push all changed members prior to build

CBedk | wers |[CEmsh | cancel |
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Cancel

Here we see the rest of the iSeries Project wizard. Here you specify what
to do for the Build action on a project. There are 3 IBM-supplied choices,
and ISVs can add more choices. The default is to generate a CL source
member containing a compile command for each member that is changed.
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Build Styles

= Specify how to build the iSeries project on the
remote system

= Three IBM supplied build styles
CL program
Command
*NONE

= [SVs can plug-in additional build styles

Remote System Explorer | Advanced © 2004, 2006 IBM Corporation

CL program
» Automatically generates COMPILE.CLLE and BIND. CLLE
* Adds compile command for each source file in project
» Uses last compile command from RSE for specified source type
* For example, CRTBNDRPG versus CRTRPGMOD
* At build time these two members are pushed to iSeries, compiled and run

Command
* You specify single command to run build

* Good if you have an existing build script

ISVs can plug-in additional build styles to work with their existing iSeries systems
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4P New [x]

iSeries Source Physical File

Create a new local source physical file under an iSeries project. %

Enter or select an iSeries Project:
[ ry iseries_CODELAB

Rl
+-128 AutoWorldExample

(>

+ 2 AutoWorldExamplsEAR

ARG Select
+-129 & Web Project

+ 128 ComparryWebSiteExample Project
+ 129 DefautEAR

+ 129 DefautEARTest
1@ My iSeries_CODELAB
+ 128 My Old Web Project
+ 128 My Project =
+ 128 My web Project

+ 128 My WF Project

ISeries Source Physical File Wizard

+ 1@ RemateSystemsConnections

% New X

iSeries Source Physical File Parameters

Specify additional parameters.

Coded character set 1D: | *10B

bl@

Record length: ‘ 11z
1GC data; r
Descripkion: ‘

These attributes are used when the *FILE is created in the associated library of the
iSeries project,

Specify attributes that are
used when file is finally
created in associated library

+ 1@ RemateSystemsTempFiles
e

Source File = a folder in your project

Fiename: [mrpaese | —Until you "Push” your changes.
advanced >> —Then a CRTSRCPF is done

Select an iSeries project and enter the name of the new saurce physical file being
created, The source physical File will map to a folder under the selected iSeries
project,

Here we see the wizard for creating a new iSeries source physical file.
Within the project, this is actually a folder. When the project is pushed to
its associated library, this result in a CRTSRCPF command being run to
create a file with the attributes specified in this wizard.



| IBM Software Group | WebSphere software

ISeries Member wizard

& New x|

iSeries Member
Create a new local source member under an iSeries project,

Enter or select a source physical file under an iSeries project:

I My iSeries_CODELABIQRPGLESRC

Member = a file in your

B folder
< B Ao —Until you "Push" your
125 A el
Select the ﬁ : xe: Ero]ect Changes-
CompanyWebSiteExample /Then an ADDPFM is
parent folder e
(SI’C f||e) =-Ta My iSeries_CODELAB done, or
QCBLLESRC
GODSSRC —Contents of remote
23 oyt oot member are replaced
s Enter the
Q; My Web Project 5
) member name -
Member name: | MYMER.
corcorpes [TE ] and select —
source type

Select an iSeries source physical file, and enter the name of the new source member
being created. The member will map to a file in the Folder representing the selected
iSeries source physical file,
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Here we see the wizard for creating a new iSeries source member within
an iSeries project. Actually, it is within a source phyical file (aka folder)
within an iSeries project. Locally, a member is really a file on disk. The
file's extension is the member's type, as in ABC.RPGLE. When this
project is pushed to its associated library, this will result in an ADDPFM
command being run to create the file with the name and type, in its parent
file.
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What about existing members?

= Use Import or Add to Project action to copy them
= Files added become folders locally

= Members added are copied to that folder

= Developer works on local copy

= Full power of Eclipse at disposal

Remote System Explorer | Advanced © 2004, 2006 IBM Corporation

Add project action
*Right click on project, select “Show Remote Objects”
*Drill down to source file, right-click, select “Add to Project”
+Drill down to members, right-click, select “Add to Project”

Developer works on local copy
*Edits file
*Pushes changes using “Push” action
*Does a build using “Build” action
*Shares with team using “Synchronize” action
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Project “Show Remote Objects” mode

& iSeries Projects - WebSphere Development Studio Client Advanced Edition for iSeries
File Edit Navigate Search Project Run  Window Help

BH-EHES | fGe |5 s-%-%-|® v CE-9

ﬁ v X EE Outline *
An outling is not
@ = 2% OCBLLESRC e 4 available.
T % PAYROLLC.CELLE Go Inko
R @ PAYROLLCZ. CELLE Open in Mew Window
% PAYROLLD.CELLE
=I-E§ oppsshe
% EMPMST.PF
02 MSTDSP.DSPR [E2ycopy
% MSTDSF2 DSPR B
% MSTDSPY DSPR q
= 2% qRrRGLESRC % Delete Currently shOWIng
1 PAYROLL.RPGLE Mave...
2 PAYROLLGRPGLE Rename only local
T T7_WFLABRY
- Ta» toras07m_ORDLIE Laglmport... resources
LYExport...
iSeries Project Mavigator Navigato
—————— Close Project
U remote Systems Refresh
B oo om|Hf Remote Actions i Job Stanus @ x
E britted [ 30b | Project | starus
2 4y Wy iseries Team » 115742 AWM 0L190HCOULTHAR/LBEH...  torasO7m_ORDLIB Finished
= B Series Objects Compare With b 3704 PM 012056/COULTHARJLEEH..,  toras07m_CROLIE Finished
+ = Wwork with libraries,
+ 2% viork with objects. Restare from Local Histary. ..
+ 3=a;> wark with member; Properties | &
+] ﬁLlhrar Jisk 2L abkashein fren

Remote Systems  Properties

Here we see an iSeries project in the iSeries Navigator, within the iSeries
Projects perspective, that has a number of local files and members. Right-
clicking on the project or anything in the project, gives a popup menu with

Tasks |iSeties Commands Log |iSeries Build Job Status |iSeries Error List | iSeties Source Prompter

the all-important "Show Remote Objects" menu item....
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Project “Show Remote Objects” mode

Now showing
both local and

& =

[+

roject Mavigakor

@ % F - resources

- 1= My iSeties_CODELAR
+ 5 QCBLLESRC (LocaljRemote)
-5 oDDSSRE {Local/Remate)

5 EMPMST.FF (Local{Remote)

% MSTDSP.DSPF {LocaliRemate)

% MSTDSP2.DSPF (Local{Remate)

% MSTDSPY.DSFF {Local/Remate

g PrIMST. pf (Remote)

% REFMST.pF (Remoate)

% RSMMST.pF (Remate)

- B qrPaLESRC (Local/Remot

0% PAYROLL.RPGLE {Locs

0% PAYROLLG RPGLE {Lad

- 5 coMPARE. *file.pf-src (Remate)

0% SAMPLEL.Ext (Remate)

[ SAMPLEZ.bxt (Remate)
EMPMST *file.pf-dta (Remats)
EYFEVEMT. *file.pf-dta (Remate)
&8 MSTDSP . *file.dspf (Remote)
PRIMST. *file.pf-dta (Remate)

+] E} QCLSRC, *File, pf-src (Remoke)

Refresh

x
e

To add a remote member to the
project, select Add To Project

To do actions against remote objects, use
Show In Remote Systems View
1

[ (Remote) => a
—only exists in associated library

(Local/Remote) => iy

—exists locally and in associated lib

(Local/Remote) => L
—conflict between Iocaﬁmd remote

otherwise =>

+ 58 QCMDSRC. #File.pf-sre (Remate) -
= o —only exists locally

+- 5 QRPGSRC. *File.pf-src (Remote)
=i wm L

v
iSeries Project Mavigator i okmarks |

| Remote System Explorer | Advanced
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Once "Show Remote Objects"” is enabled (it is a toggle) all the objects in
the associated library for this project are shown in the iSeries Project
Navigator. This navigator is called a "bleed through" view because it lists
both local files/members and remote objects, files and members. However,
if a file or member exists both locally and remotely, it is not shown twice.
Rather, it is only shown once, and its icon and bracketed text identify it as
existing in both places. The icons and text enable you to see at a glance
which files/members exist only locally, only remotely, or both locally and
remotely. In the latter case, the color of the icon indicates if the two are in
synch or not. If not, it is an indication you need to "push” your local source
to the associated library to get it in synch.
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Project Build

Progress Information

G Ele|

Pushing Changed Resources,
Mew 13
Go Inta

Open in Mew Window

5 QCBLLESRC (Local
1= Ef QDDSSRC (LocaljR

[ = L ey N S
[ MSTDSP.DSPF Import Remote Objects,..
I MSTDSP2.DSPY

CODELAB{QDDSSRE(MSTDSPY)

v Show Remote Objects
MSTDSPY.DSFE—————————————
PRIMST.pf (Re  [EZ)Copy ‘
- REFMST.pF (R e N
I RSMMST.pF (R I
=[5 QRPELESRC (Locy ¥ Delete
| R TR e After editing, you
- [ PAYROLLG.RP Rename 3
= Ef compare Mlepft
O SAMPLELbxt peglmport... L | can pUSh and
- SAMPLEZESE | L AEport... 2
- EMPMST HMfilepfodf ————— bu"d yOUf
EWFEVENT. *flle.pf Clase Project
88 MSTDSP, *file.dspf Refresh ’Chanqes
~[EF PROMST. *file, pf-dt -
1+-5§ QCLsRC *file.pf-s 8 B, wiork With Compile Commands. ..
i E§ QemMDsRC. #file,pf Team y|  Select Compile Command () v
B QRPGSRC #file.pf- i
¥ % 2 =P Compare With Generate COMPILE.CLLE I
iSeries Project Navigator INav Replace With 3
Restore from Local History.., Push Changes
U Remote Systems Push Selected
Properties

[y PAYROLLGwpg

F

Remote System Explorer | Advanced © 2004, 2006 IBM Corporation

After editing, you will want to send the changed members back to the associated
library, and then compile them there. This can be done in one step with Submit
Build, or in two steps with Push Selected and then Generate COMPILE.CLLE.
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iISeries Build Job Status

Job where build Status of the
is running . 1 build

Project Status
Sep 16, 2003 11:57:42 &M 011903/COULTHARLEEH...  koras07m_ORDLIE Finished
Sep 18, 2003 8:37:04 PM 012056/COULTHAR/LBEH...  horasO7m_ORDLIE Finished Cancel

Maov 2, 2003 £:33:49 PM 035448/COULTHAR[LBEH... My iSeties_CODELAB Queued Retrieve Errors

Remove

ml ¥ |Refresh Interval: 30 s=conds
iSeries Commands Log iSeries Build Job Status | iSeries Error List

Refresh interval
determines how frequently Retrieve errors from
status is updated build to the

iSeries Error List

T W |

Remote System Explorer | Advanced © 2004, 2006 IBM Corporation

This shows the Build Job Status view where you can monitor your
submitted build jobs.
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4P iSeries Projects - COMPILE.CLLE - WebSphere Development Studio Client Advanced Edition for iSeries

File Edit Spurce Compile Navigate Search Projeck Run  Wwindow Help

| 5 - sllaFs|[B]F-%-S-[®s|ve-2-|a6/mmr|afh

= > x || FCoMPLE.CLE x]

% a2 E |C§3| o $¢ Row l. Column 1 Replace

@ = 1= My iSeries_CODELAE u L z 3 4 .

. =B ocBLLESRC 000100 PGH

T 000200 DCL <FAILED TYFE(*DEC) LEN(10 0) VALUE(0O)

’E 000300 DCL SFAILEDSTE TYPE(*CHAR) LEN(10)

= 000400
000500 CHGPF SRCFILE (CODELAB/QDDSSRC) SRCMER (EMPMST) OPTICH(
000600 M5T)

1= T7_WFLAERY
b boras07m ORDLIE 000700 NCNMSG MSGID (CPFO000) EXEC (DO)

000800 CHGVAR VAR({sFAILED) VALUE (sFAILED + 1)

000500 ENDDO

001000

001100 CRTDSFF SECFILE {CODELAB/QDDSSRC) SRCHMER(MSTDSP) REFLL
001200 FILE (CODELLE/ MSTDSF)

001300 NCHMSG MSGID(CPFODO0) EXEC (DO

001400 CHGVAR VAR(|&FAILED) VALUE(SFAILED + 1)

< il |

iSeries Project Navigator ] Mavigator |Bookmarks I

UE) Remate Systems - x [ iSeries Build Job Status

ES S§3 c o & | o 4, Date|Time Submitted | 300 | Project Status
L Sep 18, 2003 11:57:42 AM 011903fCOULTHARMLBEH...  toras07m_ORDLIB Finishe
i @ PAYROLLG.rpgle || | Sep 18, 2003 8:37:04 PM 012056/COULTHARFLBEH...  toras07m_ORDLIB Finishe
i* iSeries Commands | mov 2, 2003 6:35:49 PM 035446/COULTHARILBEH. .. My iSeries_CODELAE Finishe

i 15eries Jobs

32, TFS Files

TORASIFE L
] | | _* |Refresh Tnterval: 30 seconds

Remote Systems JPerertiss Tasks |iSeries Zommands Log IiSsries Build Job Status | iSeries Error List

Lacal Membet: My iSeries CODELABIQCLSRC/COMPILE.CLLE
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An example of what is generated for the build. This is a CL member. You can affect
what compile command is used for each member type.
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. . Prod Lib
Using Projects
Test Lib

library list library|list library list

7 I .
Devl Lib Dev2 Lib Dev3 Lib

A

Team push push push

Re ository build build build
Devl IDE Dev?2 IDE Dev3 IDE

< * team * team * team

sync sync sync
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The typical usage scenario for iSeries projects is to use them for tasks,
such as adding a feature to an existing application. Rarely will you use an
iSeries project to hold all the source for an application... use an iSeries
change management vendor for that. Consider a change that involves 3
developers changing a number of files...

The lead developer will create the iSeries project and synchronize it with
the repository. The other developers will use the Eclipse team support to
add that project to their workspace. Each will change the properties of the
project to associate it with their own private library. The master library
containing all the source will be on their library list, so compiles will work,
but their private library will only hold the members they work on. If they use
an SCM product, then they will use it to check source members out to their
private library. These members and files will then be imported into their
project, where they will edit them.

After editing, they will "push” their changes to their library and do a "Build"
or a compile, and run and test their unique changes.

Every so often, they will do a team synchronization to give their changes to
their fellow team members, and pick up the changes of those team
members. After a synch, they will push their colleaque'’s files to their own
associated library and test the changes all work together.

At the end of the cycle, someone will pick one of the libraries, and use the
SCM product to promote their changes back into the test and production
stages.
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Profiles

= The RSE is designed for team sharing
— Of connections
— Of filter pools
— Of user-defined actions
— Of compile commands
= Team sharing is enabled by profiles
— All connections, filter pools, user actions are scoped per profile
— Each profile is a folder within the RSE project
— All data stored within subfolders
— When RSE project is team-synched
— All out-going changes sent to team repository
— All in-coming changes received from team repository
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We see that with the RSE you will be creating connections, filter pools,
user defined actions and compile commands. In a team environment, we
might wish to share some or all of this information to save the effort of
each team member having to redundantly create them. This is especially
for team members working on a shared task, such as mainenance of an
application. The RSE leverages the Eclipse team support to enable this.

The first order of business for effectively enable team support is to allow
delineation between "team" information and "private" information per
developer. The RSE enables this by using profiles. Every bit of
information you create in the RSE is owned by a specific profile, and each
developer decides which profiles they wish to see the information of. Team
sharing is done using the Eclipse team support, which uses a central
repository, and a "synchronize" action to synchronize individual
developer's information with the repository.
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Additional Information

“homepage:
http://ibm.com/software/awdtools/iseries
Select Library link for Labs, Tutorials, Presentations

“newsgroup:

news://news.software.ibm.com/ibm.software.websphere.code400

=email distribution list;:

“This 'il's th? Websphere Development Studio Client for iSeries (WDSCI-L)
mailing list
To post a message email: WDSCI-L@midrange.com
To subscribe, unsubscribe, or change list options,
visit: http://lists.midrange.com/mailman/listinfo/wdsci-
or email: WDSCI-L-request@midrange.com
Before posting, please take a moment to review the archives
at http://archive.midrange.com/wdsci-1.”
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We hope this presentation helped you understand more about Development Studio
Client iSeries application development tools. We started with an overview of our
strategy for iSeries application development tools, went onto review the Remote
System Explorer, the perspective for iSeries programmers to maintain and develop
iSeries applications and explained how to extend RSE to include your own iSeries
application development tools.
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